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Section 1: New Sage Residential
Management Installation

You must install Sage 300 Construction and Real Estate Accounting and Management products version
14.1 before you install Sage Residential Management version 14.1. If you also purchased Sage
Estimating, also install Sage Estimating version 14.1 before you install Sage Residential Management
version 14.1.

Installation steps for the server that will host Residential
Management data or a atandalone workstation

A. Prepare to install to the server or standalone workstation

1. The Residential Management application uses Crystal Reports components that come with the
Sage 300 Construction and Real Estate Accounting and Management products. Before you install
Residential Management 14.1, you must install Accounting and Management Products 14.1 to
each computer that will have Residential Management. (This does not include remote
workstations, to which you do not install Residential Management.)

2. If you have other applications that use Microsoft Database Engine or Structured Query Language
(SQL) database engines, make sure that the database engines are compatible. For more
information, see “Minimum System Requirements” on page 17

3. Quit all programs and services for the duration of the installation. This includes programs that run in
the background such as antivirus, e-mail, backup, and virtual firewall programs.

4. If you set up Residential Management on a network, set up a user or group named RmsAdmins in
the active directory on the domain server. This RmsAdmins user or group must have full network
administrative rights.

5. Have a copy of the Residential Management 14.1 software notice available. The notice provides
instructions and a link for downloading the Residential Management installation files.

B. Open the RM Setup Main Menu at the Server or Standalone Workstatio

1. Log on with administrative rights.

2. Download the Residential Management installation files to your server in accordance with the
software notice instructions.

3. Inthe resulting RM installation folder, browse for the Setup.htm file and double-click it to open the
RM Setup Main Menu window.

C. Install Residential Management at the Server or Standalone Workstation

1. From the RM Setup Main Menu, click 2. Install RM Program Files.
2. Inthe File Download window, click [Open].

3. Inthe Residential Management - InstallShield Wizard window, click [Next].
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Section 1: New Sage Residential Management Installation

Type your user name and organization, select Anyone who uses this computer (All Users), and
click [Next].

Make sure that C:\RM\ appears as the destination folder (C: represents your local drive) and click
[Next]].

Select Typical as the Setup Type and click [Next]
Click [Next] and click [Install]. The installation may take several minutes.

Close the RM Setup Main Menu window.

D. Install SQL Server Express to the server or standalone workstation

If you have already installed Microsoft SQL Server 2005 or Microsoft SQL Server 2005 Express to your
server and you have a SAGERM instance, skip to “E. Ensure remote connections are allowed on the
server’ on page 3.

[ﬂ NOTE: If you are installing SQL Server Express on a Windows Server 2008 or Windows 7 operating

system, you will need to install Microsoft SQL Server 2005 Express Edition Service Pack 4 from the
Microsoft website:
http://www.microsoft.com/en-us/download/details.aspx?id=184

For SQL Server 2005 Express Edition installation:

1.

Using Windows Explorer, browse to C:\RM\RMDatabase (C: represents your RM install location).
If you are installing Microsoft SQL Server 2005 Express Edition Service Pack 4, browse to the
location where you downloaded it.

2. Click SQLEXPR.EXE (or SQLEXPR32.EXE for 32-bit operating systems).

3. Afterreading the End User License Agreement, select | accept the licensing terms and
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10.

conditions, and then click [Next].

In the Installing Prerequisites window, click [Install] to begin the installation.

When you see "The required components were installed successfully" message, click [Next].
Inthe Welcome to the Microsoft SQL Server Installation Wizard window, click [Next].

In the System Configuration Check window, confirm that all actions were successful, and then
click [Next].

In the Registration Information window, after entering your registration information, clear the
Hide advanced configuration options check box, and then click [Next]].

NOTE: You must clear the Hide advanced configuration options check box to perform the
remaining steps.

In the Feature Selection window, click [Next].

In the Instance Name window, select Named instance, type SAGERM for the named instance,
and then click [Next].
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Section 1: New Sage Residential Management Installation

11.

12.

13.

14.
15.
16.
17.
18.

If this is a domain server, in the Service Account window select Use a domain user and then

type your user name, password, and domain in the appropriate boxes. If there is no domain, select

Local system. Select the SQL Server and SQL Browser services boxes at the bottom of the
window. Then click [Next].

In the Authentication Mode window, select the following:
a. Select Mixed Mode (Windows Authentication and SQL Server Authentication).

b. Enterand confirm the password for sa logon (system administrator logon).
NOTE: Itis important to make note of this password as it may be required when you
perform database maintenance.

c. Click [Next].

Inthe Collation Settings window, select SQL collations (used for compatibility with previous

versions of SQL Server). Ensure that Dictionary order, case-insensitive, for use with 1252

Character Setis selected (this is the default), and then click [Next].

In the Configuration Options window, select Enable User Instances, and then click [Next].
Inthe Error and Usage Report Settings window, click [Next].

In the Ready to Install window, click [Install].

When the setup is finished, click [Next].

Inthe Completing Microsoft SQL Server 2005 Setup window, click [Finish].

E. Ensure remote connections are allowed on the server

NOTE: These steps are not required for a standalone workstation.

1.
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10.
11.
12.

In the Windows task bar, select Start > Programs > Microsoft SQL Server 2005 >
Configuration Tools > SQL Server Surface Area Configuration.

Select Surface Area Configuration for Services and Connections.

Under SAGERM, expand Database Engine, then select Remote Connections.

Select Local and remote connections, then select Using both TCP/IP and named pipes.
Click [Apply] then [OK].

When the “Changes to Connection Settings will not take effect until you restart the Database
Engine service” message appears, click [OK].

Exit the SQL Server Surface Area Configuration window.

In the Windows task bar, select Start > Programs > Microsoft SQL Server 2005 >
Configuration Tools > SQL Server Configuration Manager.

Select SQL Server 2005 Services.
Select SQL Server (SAGERM).
Select Restart Service or right-click and select Restart.

Exit the SQL Server Configuration Manager window.

Sage Residential Management Version 14.1 Installation Guide

Page 3



Section 1: New Sage Residential Management Installation

F. Create the RM sample database (RM_Demo)

You can create sample data to use with Residential Management. This process also creates the
necessary logins for SQL so this is a required step.

Browse to your C:\RM\RMDatabase folder and double-click RMDatabase.exe.
RM_Demo should appear in the Database Name field.

Click [Create] and then click [OK].

In the Login Info window, enter your sa login and password, and then click [Accept].
A message appears when the database has been created. Click [OK].

Click [Upgrade] and then click [OK].

In the Login Info window, enter your sa login and password, and then click [Accept]
A message appears when the database has been upgraded. Click [OK].

Click [Exit].
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G. Update Shortcut Properties

Perform the steps in this section only if you are using RM for the first time or if you have not set up security
in RM.

1. Right-click the RM icon on your desktop, and select Properties.

2. Click the Shortcut tab. Verify that the Target field displays C:\RM\RM.exe (C: represents your
local drive).

3. Inthe Targetfield, place your cursor at the end of the path. Enter a space, and then type
RmsAdmins. The Target field should read “C:\RM\RM.exe” RmsAdmins.

4. Click [Apply], and then click [OK].

H. Start Residential Management

NOTE: Ensure you start Sage 300 Construction and Real Estate before starting Residential
Management to allow the Sage System Verifier to perform system verification. If you do not start
Sage 300 Construction and Real Estate before starting Residential Management, you will receive a
“cannot find SQL servers” error message. If you receive this message, close Residential
Management, start Sage 300 Construction and Real Estate and allow the Sage System Verifier to
run, and then try starting Residential Management again.

1. Launch the RM icon that was just updated in step “G. Update Shortcut Properties.”

2. If you see a message concerning the NT group, click [OK].
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Section 1: New Sage Residential Management Installation

3. Select or enter the SQL server name. On the server that hosts the data or a stand-alone
workstation, the SQL server name will be (local \SAGERM.

4. Select the database that you want to use. If Residential Management does not find a database,
follow the instructions in “Appendix A: Reset the Registry” on page 19.

5. Select the property that you want to use. The Residential Management window appears.

Installation Steps for Workstations or Terminal Servers (not
hosting the data)

A. Prepare to Install

1. The Residential Management application uses Crystal Reports components that come with the
Sage 300 Construction and Real Estate Accounting and Management products. Before you install
Residential Management 14.1, you must install Accounting and Management Products 14.1 to
each computer that will have Residential Management.

Log on to the workstation as an administrator.

3. Quit all programs and services for the duration of the installation. This includes programs that run in
the background such as antivirus, e-mail, backup, and virtual firewall programs.

4. The workstation user or operator must have workstation administrative rights in order to use
Residential Management.

B. Open the RM Setup Main Menu

1. Download the Residential Management installation files to your workstation or terminal server in
accordance with the software notice instructions or copy them from a shared location if they were
previously downloaded to a shared location.

2. Intheresulting RM installation folder, browse for the Setup.htm file and double-click it to open the
RM Setup Main Menu window.

C. Install Residential Management

From the RM Setup Main Menu, click 2. Install RM Program Files.
In the File Download window, click [Open].

In the Residential Management - InstallShield Wizard window, click [Next].

Ao~

Type your user name and organization, select Anyone who uses this computer (All Users), and
click [Next].

5. Make sure that C:\RM\ appears as the destination folder (C: represents your local drive) and click
[Next].

6. Select Typical as the Setup Type and click [Next].
7. Click [Next] and click [Install]. The installation may take several minutes.

8. Close the RM Setup Main Menu window.
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Section 1: New Sage Residential Management Installation

D. Install SQL Server Express

[ﬂ NOTE: If you are installing SQL Server Express on a Windows Server 2008 or Windows 7 operating
system, you will need to install Microsoft SQL Server 2005 Express Edition Service Pack 4 from the
Microsoft website. http://www.microsoft.com/en-us/download/details.aspx?id=184

For SQL Server 2005 Express Edition installation, do the following:

1. Using Windows Explorer, browse to C:\RM\RMDatabase (C: represents your RM install location).
If you are installing Microsoft SQL Server 2005 Express Edition Service Pack 4, browse to the
location where you downloaded it.

2. Click SQLEXPR.EXE (or SQLEXPR32.EXE for 32-bit operating systems).

3. Afterreading the End User License Agreement, select | accept the licensing terms and
conditions, and then click [Next].

In the Installing Prerequisites window, click [Install] to begin the installation.
When you see "The required components were installed successfully" message, click [Next].

Inthe Welcome to the Microsoft SQL Server Installation Wizard window, click [Next].
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In the System Configuration Check window, confirm that all actions were successful, and then
click [Next].

8. Inthe Registration Information window, after entering your registration information, clear the Hide
advanced configuration options check box, and then click [Next].
NOTE: You must clear the Hide advanced configuration options check box to perform the
remaining steps.

9. Inthe Feature Selection window, select Client Components and Connectivity Components.
Then click [Next].

10. Inthe Instance Name window, select Named instance, type SAGERM in the named instance
box, and then click [Next].

11. Inthe Service Account window, select Network service. Mark the SQL Server and SQL
Browser services boxes at the bottom of the window. Then click [Next].

12. Inthe Authentication Mode window, select the following:
a. Select Mixed Mode (Windows Authentication and SQL Server Authentication).

b. Enterand confirm the password for sa logon (system administrator logon).
NOTE: Itis important to make note of this password as it may be required when you
perform maintenance.

c. Click [Next].

13. Inthe Collation Settings window, select SQL collations (used for compatibility with previous
versions of SQL Server). Ensure that Dictionary order, case-insensitive, for use with 1252
Character Setis selected (this is the default), and then click [Next].

14. Inthe Configuration Options window, select Enable User Instances, and then click [Next].

15. Inthe Error and Usage Report Settings window, click [Next]
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Section 1: New Sage Residential Management Installation

16. Inthe Ready to Install window, click [Install]
17. When the setup is finished, click [Next].
18. Inthe Completing Microsoft SQL Server 2005 Setup window, click [Finish].

E. Update Shortcut Properties

Perform the steps in this section only if you are using RM for the first time or if you have not set up security
in RM.

1. Right-click the RM icon on your desktop, and select Properties.

2. Click the Shortcut tab. Verify that the Target field displays C:\RM\RM.exe (C: represents your
local drive).

3. Inthe Target field, place your cursor at the end of the path. Enter a space, and then type
RmsAdmins. The Target field should read “C:\RM\RM.exe” RmsAdmins.

4. Click [Apply], then click [OK].
F. Start Residential Management

[E NOTE: Ensure you start Sage 300 Construction and Real Estate before starting Residential
Management to allow the Sage System Verifier to perform system verification. If you do not start
Sage 300 Construction and Real Estate before starting Residential Management, you will receive a
“cannot find SQL servers” error message. If you receive this message, close Residential
Management, start Sage 300 Construction and Real Estate and allow the Sage System Verifier to
run, and then try starting Residential Management again.

1. Launch the RM icon that was just updated in step “E. Update Shortcut Properties”.
If you see a message concerning the NT group, click [OK].

3. Select or enter the SQL server name. On a workstation or terminal server, the SQL server name will
be [server name]\SAGERM. For example if the name of the server that hosts the data is
DATASERVER, the SQL server name will be DATASERVER\SAGERM.

4. Select the database that you want to use. If Residential Management does not find a database,
follow the instructions in “Appendix A: Reset the Registry” on page 19.

5. Select the property that you want to use. The Residential Management window appears.
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Section 2: Upgrade Sage Residential
Management

You must upgrade Sage 300 Construction and Real Estate Accounting and Management products to
version 14.1 before you upgrade Residential Management to version 14.1. If you also have Sage
Estimating installed, also upgrade Sage Estimating to version 14.1 before you upgrade Residential
Management to version 14.1.

Supported Upgrade Paths

You can upgrade to Sage Residential Management version 14.1 from Residential Management 9.4.0 or
later.

Upgrade Steps

A. Prepare to Upgrade

1. The Residential Management application uses Crystal Reports components that come with Sage
300 Construction and Real Estate Accounting and Management products. Before you upgrade to
Residential Management 14.1, you must install or upgrade to Accounting and Management
Products 14.1 on each computer that will have Residential Management. (This does not include
remote workstations, to which you do not install Residential Management.)

2. Back up your Residential Management data files.

3. If you have other applications that use Microsoft Database Engine or Structured Query Language
(SQL) database engines, make sure that the database engines are compatible. For more
information, see “Section 4: Creating a new Sage Residential Management Database File.”

4. If you have MSDE version 1, MSDE version 2, SQL Server version 7, or SQL Server 2000 installed,
follow the instructions in the Moving Data Files document before you upgrade. This and other
guides are available on the Product Documents website.

5. If you are upgrading from version 9.4, follow the steps in Section 1 for a new installation. If you are
upgrading from version 9.5 or later, continue with the steps below.

6. If you plan to upgrade a network installation, ask all operators to close Residential Management for
the duration of the installation

7. Quit all programs and services for the duration of the installation. This includes programs that runin
the background such as antivirus, e-mail, backup, and virtual firewall programs.

8. Have a copy of the Residential Management version 14.1 software notice available. The notice
provides instructions and a link for downloading the Residential Management installation files.
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Section 2: Upgrade Sage Residential Management

B. Open the RM Setup Main Menu

Perform the steps in this section on all servers, terminal servers and workstations that use Residential
Management.

1. Download the Residential Management installation files to your server, terminal server, or
workstation in accordance with the software notice instructions or copy them from a shared
location if they were previously downloaded to a shared location.

2. Inthe resulting RM installation folder, browse for the Setup.htm file and double-click it to open the
RM Setup Main Menu window.

C. Upgrade Residential Management

Perform the steps in this section on all servers, terminal servers and workstations that use Residential
Management.

1. From the RM Setup Main Menu, click 2. Install RM Program Files.
2. Inthe File Download window, click [Open].

In the Residential Management - InstallShield Wizard window, click [Next]. The installation of
the upgrade may take several minutes.

4. Type your user name and organization, select Anyone who uses this computer (All Users), and
click [Next].

5. Make sure that C:\RM\ appears as the destination folder (C: represents your local drive) and click
[Next].

6. Select Typical as the Setup Type and click [Next].
7. Click [Next] and click [Install]. The installation may take several minutes.

8. Close the RM Setup Main Menu window.

D. Upgrade Residential Management Data Files

Perform these steps on the computer that hosts your Residential Management data files. If you have more
than one database that you use with Residential Management, repeat these steps for each database.

1. Browse to your C:\RM\RMDatabase folder and double-click RMDatabase.exe.

Inthe RM Data Installation window, change the Data Location to the directory where the RM
data resides, if necessary.

Change the name in the Database Name field to the name of your database to be upgraded.
Click [Upgrade] and then click [OK].

In the Login Info window, enter your sa login and password, and then click [Accept].

A message appears when the database has been upgraded. Click [OK].

Repeat for any additional databases to be upgrade.

When finished, click [Exit].
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Section 2: Upgrade Sage Residential Management

E. Update Shortcut Properties

Perform the steps in this section on all servers, terminal servers and workstations that use Residential
Management and if you have not set up security in RM.
1. Right-click the RM icon on your desktop, and select Properties.

2. Click the Shortcut tab. Verify that the Target field displays C:\RM\RM.exe (C: represents your
local drive).

3. Inthe Target field, place your cursor at the end of the path. Enter a space, and then type R
msAdmins. The Target field should read “C:\RM\RM.exe” RmsAdmins.

4. Click [Apply], then click [OK].

F. Start Residential Management

Perform the steps in this section on all servers, terminal servers and workstations that use Residential
Management.

NOTE: Ensure you start Sage 300 Construction and Real Estate before starting Residential
Management to allow the Sage System Verifier to perform system verification. If you do not start
Sage 300 Construction and Real Estate before starting Residential Management, you will receive a
“cannot find SQL servers” error message. If you receive this message, close Residential
Management, start Sage 300 Construction and Real Estate and allow the Sage System Verifier to
run, and then try starting Residential Management again.

1. Double-click the RM icon that was just updated in step E.
2. If you see a message concerning the NT group, click [OK].
3. Select or enter the SQL server name.

o Onthe server that hosts the data or a stand-alone workstation, the SQL server name will be
(loca\SAGERM.

o On aworkstation or terminal server, the SQL server name will be [server name\SAGERM.
For example if the name of the server that hosts the datais DATASERVER, the SQL server
name will be DATASERVER\SAGERM

4. Select the database that you want to use. If Residential Management does not find a database,
follow the instructions in “Appendix A: Reset the Registry” on page 19.

5. Select the property that you want to use. The Residential Management window appears.
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Section 3: Migrate Sage Residential
Management to a Different Server

A. Follow the instructions in Section 1 for a new installation on the new server

B. Detach the RM databases from SQL on the old server

Perform these steps on the old server that hosts your Residential Management data files. If you have more
than one database that you use with Residential Management, repeat these steps for each database.

1.
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8.

Browse to your C:\RM\RMDatabase folder and double-click RMDatabase.exe.

In the RM Data Installation window, change the Data Location to the directory where the RM
data resides, if necessary.

Change the name in the Database Name field to the name of your database to be upgraded.
Click [Detach] and then click [OK].

In the Login Info window, enter your sa login and password, and then click [Accept].

A message appears when the database has been detached. Click [OK].

Repeat for any additional databases to be detached.

When finished, click [Exit].

C. Copy your RM databases from the old server to the new server

The default location for the RM SQL database depends on your operating system and may be one of the
following:

o C:\Program Files\Microsoft SQL Serve\MSSQL.1\MSSQL\Data
o C:\Program Files (x86)\Microsoft SQL ServenMSSQL.1\MSSQL\Data

NOTE: If you have multiple instances of SQL installed, your data may be in another MSSQL. [#]

folder (MSSQL.2, MSSQL.3, etc.).

D. Attach your RM databases to the new server

Perform these steps on the new server that hosts your Residential Management data files. If you have
more than one database that you use with Residential Management, repeat these steps for each
database.

1.
2.

Browse to your C:\RM\RMDatabase folder and double-click RMDatabase.exe.

In the RM Data Installation window, change the Data Location to the directory where the RM
dataresides, if necessary.

3. Change the name in the Database Name field to the name of your database to be attached.
4. Click [Attach] and then click [OK].

In the Login Info window, enter your sa login and password, and then click [Accept].
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Section 3: Migrate Sage Residential Management to a Different Server

6. A message appears when the database has been attached. Click [OK].
7. Repeat for any additional databases to be attached.
8. When finished, click [Exit].

E. Reset the Registry on the workstations

The registry key on the workstations (and terminal servers not hosting the data) will be set to the old
server. Update the registry key HKEY_CURRENT_USER > Software > Timberline > Residential
Management > ConnectionString to use the new server by performing the following steps:

1. Login as the user on the workstation or terminal server, and then use Windows Explorer to browse
to the C:\RM directory.

2. Double-click the file ResetRegistry.vbs. You will not see any action as a result of clicking this file.

3. Close the Windows Explorer.

F. Start Residential Management

Perform the steps in this section on all workstations and terminal servers that use Residential
Management.

. NOTE: Ensure you start Sage 300 Construction and Real Estate before starting Residential
Management to allow the Sage System Verifier to perform system verification. If you do not start
Sage 300 Construction and Real Estate before starting Residential Management, you will receive a
“cannot find SQL servers” error message. If you receive this message, close Residential
Management, start Sage 300 Construction and Real Estate and allow the Sage System Verifier to
run, and then try starting Residential Management again.

1. Launch the RM icon.
2. If you see a message concerning the NT group, click [OK].

Select or enter the SQL server name. On a workstation or terminal server, the SQL server name will
be [server name]\SAGERM. For example if the name of the server that hosts the data is
DATASERVER, the SQL server name will be DATASERVER\SAGERM.

Select the database that you want to use.
Select the property that you want to use. The Residential Management window appears.

6. You may receive a message “The Sage Timberline Office data folder field for [database name] is
empty or does not contain a valid data folder. Please select a valid data folder. [RM0030]”. Click
[OK] then click [Browse] to select the new location for the Accounting data.

7. You will receive a message “Warning! Changing the Sage Timberline Office Data Folder after
processing has occurred may cause data inconsistencies. Are you sure you want to continue?
[RMO0012]". If you have selected the correct Timberline Office folder for the Accounting date, click
[OK].

8. Click [OK].
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Section 3: Migrate Sage Residential Management to a Different Server

G. Update Residential Management settings, copy custom reports and RMToday

1. In Residential Management, from Adv Setup, select System Settings.

2. Update the ReportDirectory to the new location if necessary then click [Save].
3. Click [Close].
4

. Copy any custom reports from the old server to the new server. Default report location is
C:\RM\Reports (or as designated in the ReportDirectory in Adv Setup > System Settings), but
you may have report designs saved in other locations. Reports saved in a different location will
display the full path in the Name column from Reports > Reports Manager.

5. Copy the RMToday folder from the old server to the new server. The RMToday folder is located in
the C:\RM directory.
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Section 4: Creating a new Sage
Residential Management Database File

Follow these steps to create the new Sage Residential Management database file.

1. Browse to the C:\RM\RM Database folder on the server.

2. Inthe RM Database folder, double-click the file DBInstaller.ini to open it in Notepad and change
the file to the following.

[Defaults]
SERVER_NAME = “(local\SAGERM
DATABASE_NAME = “RMEmpty"
CD_MDF_PATH = “\RMEmpty9_0.mdf"
CD_LDF_PATH = "\RMEmpty9_0_log.|df"
NOTE: The files inthe CD_MDF_Path and CD_LDF_Path must be exactly the same in the
DBInstaller.ini file as they are in the actual path in your system.
From the File menu, select Save and then click Exit.
In the RMDatabase folder, double-click the file RMDatabase.exe.
In File Locations, verify the Server and Data Location fields.
o The Server field should point to the SAGERM instance.

o The Data Location field should point to the root level of the data folder where your
Residential Management data files are stored.

In the Database Name field, change RMEmpty to the database name you want to create.
Click [Create] to create a new Residential Management database file.

In the Database Installer window, click [OK] to create the database.

© ® N

In the Login Information window in the Login field, type your SQL sa login and password and
click [Accept].

10. When the installation is complete, click [OK]. In the RM Data Installation window, click [Exit].
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Section 5: Setting up Security

Sage Residential Management Security uses Active Directory on the Domain Server.
A. Create the RmsAdmins user group and other needed groups on the domain server.

1. Make sure that the RmsAdmins user group is setup on the domain server. The users in this group
should have full admin rights. Typically the users in the group would be the network admin and any
other users that will have full access in RM.

Note: The group should be a Global Group type.

2. All other RM users should be setup as users on this domain. All of these users must have full
read/write access.

TIP: You may want to setup multiple groups on the domain where each group will be assigned
specific options in RM Security. For example, you may have a group established where the users in
this group would only have access to the functions under Traffic and Cash Receipts under Tasks.
And then another group that has access to the functions under Leases, and so on. You would assign
the users to those particular groups on the domain then assign the groups to the appropriate options
in RM Security. This will make the management of RM Security much simpler because you would
only need to add/remove users from the domain group instead of having to add/remove the user from
each option in RM Security.

B. Launch RM with RmsAdmins in the Shortcut Properties

1. While logged into the domain and with RmsAdmins in the RM shortcut properties, launch
Residential Management.

2. From the shortcut bar, select Adv.Setup.

3. Double-click Security. This may take a few minutes to open as it is loading all the users and groups
from the domain.

4. Inthe left pane are the security categories (Functions, Menu Items, Properties, Controls,
Actions). Beneath each category are items to which users and groups can be applied to grant them
access to that item. Double-click a category to access the menus and items.

5. Select anitem from the left pane. On the right pane, select the user or group to add. Click the left
arrow button to add the user or group to the item. The middle pane will show the users and groups
that have access to that item.

6. If you need to remove a user or group from an item, select the user or group from the middle pane
and click the right arrow button to remove them from that item.

7. After all users and groups have been added/removed from the appropriate items, click Save then
Close.
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Section 5: Setting up Security

C. Remove Added Shortcut Properties

Once you have set up security in Residential Management, remove RmsAdmins from the Shortcut
Properties.

1. Right-click the RM icon on your desktop, and select Properties.
2. Inthe Target field, delete RmsAdmins.
3. Click [Apply], and then click [OK].
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Section 6: System Requirements

The hardware and software requirements below provide a guideline. For more detailed information, please
contact your Sage business partner or sales representative.

Supported Operating Systems

CAUTION: Residential Management is not supported on the Windows 8, Windows 8.1, Windows
Server 2012, or Windows Server 2012 R2 operating systems.

Operating System Minimum Service Pack | Notes

64-bit operating systems

Windows 2008 Server NOTE: Within this document,
Small Business Server “Window 2008 Server” refers to all supported
editions unless noted specifically.

Windows 2008 Server SP2

Enterprise Edition

Windows 2008 Server SP2

Standard Edition

Windows 2008 Server R2

Enterprise Edition

Windows 2008 Server R2

Standard Edition

Windows 7 Professional SP1 NOTE: Within this document, “Window 7”
refers to all supported editions unless noted
specifically.

Windows 7 Ultimate SP1

Windows 7 Enterprise SP1

Windows Vista Business SP2 NOTE: Within this document, “Vista” refers
to all supported editions unless noted
specifically.

Windows Vista Ultimate SP2

Minimum System Requirements
= Microsoft SQL Server 2005 or Microsoft SQL Server 2005 Express

Processor
= 800 MHz PC
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Section 6: System Requirements

RAM
= 512 MB RAM for Windows Server 2003
= 256 MB RAM for Windows XP Professional

Hard Disk Space
= Remote workstation connected to a terminal server: 0 MB
= Workstation connected to a server in a local area network: 580 MB

= Server or stand-alone computer: 580 MB

Other Requirements

= Crystal Reports For Sage 2013 SP2 (if you plan to modify or create Crystal Reports designs)
= High-quality network interface card

= Sound card (Sound Blaster®-compatible)

= SVGA monitor (800 x 600 pixels, 1024 x 768 pixels (recommended for Project Management and
Database Editor)

= Microsoft Internet Explorer 6.0 (Service Pack 1)
= Microsoft Outlook® (required to use email features)
= Printer

= WinFax Pro 10.0, 10.01, or 10.03 (required to send faxes in applications with this feature)

Supported Protocols
= TCP/IP Transmission Control Protocol/Internet Protocol. Microsoft servers default to this protocol.

= RDP 5 Remote Display Protocol. Microsoft remote protocol, which is used in its remote connection
applications.

= |CA Independent Computing Architecture. Citrix remote protocol, which is used in its remote connection
application.
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Appendix A: Reset the Registry

If Residential Management does not find a database or is pointing to the wrong server, reset the registry.

1. Use Windows Explorer to browse to the C:\RM directory.
2. Double-click the file ResetRegistry.vbs. You will not see any action as a result of clicking this file.

3. Close the Windows Explorer window.
Note: Ensure you start Sage 300 Construction and Real Estate before starting Residential
Management to allow the Sage System Verifier to perform system verification. If you do not start
Sage 300 Construction and Real Estate before starting Residential Management, you will receive a
“cannot find SQL servers” error message. If you receive this message, close Residential
Management, start Sage 300 Construction and Real Estate and allow the Sage System Verifier to
run, and then try starting Residential Management again.

4. Launchthe RMicon.
If you see a message concerning the NT group, click [OK].
6. Select or enter the SQL server name.

o Onthe server that hosts the data or a stand-alone workstation, the SQL server name will be
(local\SAGERM.

¢ On aworkstation or terminal server, the SQL server name will be [server name\SAGERM.
For example if the name of the server that hosts the datais DATASERVER, the SQL server
name will be DATASERVER\SAGERM.

7. Select the database that you want to use.

8. Select the property that you want to use. The Residential Management window appears.
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